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Introduction

Thank you for purchasing this Focus Enhancements portable direct-
to-edit (DTE) disk recorder. The FireStore FS-4 and FS-4 HD and the
professional version FS-4 Pro and FS-4 Pro HD are the first portable
DV disk recorders with DTE technology designed for hand held
camcorders in a small, rugged and shock proof chassis.

Information About Specific FS-4 Models
Throughout this manual, FS-4 indicates information that pertains to all
models of the FS-4 family. FS-4 Pro indicates data specific to the FS- 4 Pro.

The acronyms DV and HD refer to the recorder’s video recording format,
digital or high definition, respectively. By default, both the FS-4 and FS-4
employ DV recording and HD is available as an option.

If you edit with applications from Adobe, Apple, Avid, Canopus,
Matrox, Pinnacle, Sonic Foundry, Ulead, and many others, FireStore's
DTE Technology is the only solution that can save you hundreds of
hours a year by recording clips to disk in your non-linear editor’s
(NLE) native file format.

DTE Eliminates Pre-edit Processing

The FS-4 DTE disk recorder eliminates the need to capture, transfer
or convert video clips before editing. The FS-4 is a stand-alone device
that records DV25 video to its disk drive as a NLE native file. The
HD versions add the capability of capturing to disk HD 720p and
1080i video from HDV camcorders equipped with a 1394 interface.
When the disk drive is connected to a computer the clips are
immediately available for editing.

Shoot, connect, and edit: it is now that easy.
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Unpacking
Verify that the FS-4 has the following items:
1. FS-4 unit
2. Power supply with cable and connector to the FS-4
3. Power cable (international only)
4. Beltclip
5. Firewire cable, four foot long, 6-pin to 4-pin
6. User guide
7. Removable Li-lon battery pack
ONote

Missing or Damaged Components

If there are missing or damaged items, contact Focus Enhancements
Support for assistance.

Email: Support@focusinfo.com

Telephone: 763-398-1658

Features

FS-4 Features
All FS-4 models offer the following features:

Tapeless acquisition

Especially equipped camcorders permit the use of Direct To
Edit (DTE) Technology to record directly from a camcorder
while shooting and without the need of a tape.

True DTE Technology

When shooting is finished, connect the FS-4 to a computer
and instantly be ready to edit in the timeline.

Files are recorded to disk as RawDV, AVI Type 1, AVI Type
2, Matrox AVI, Canopus AVI, or QuickTime. In addition, 24p
AVI Type 2 and QuickTime are available in NTSC mode.
Fast and Efficient Editing

When shooting is finished, mount the FS-4 to a Mac or PC
editing system like a typical FireWire hard disk drive.
Transfer clips to your NLE's media drive at up to 400 Mbps
or edit instantly in real-time using the FS-4 as your media
source.
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Confidence in Recording

Simultaneously record to disk and tape while you shoot,
providing an immediately available, drop out free, edit source
and an archive and backup on tape.

Compact, Lightweight, Rugged Design

The FireStore FS-4 weighs less than one pound including the
battery and is only 1.5" thick. You can mount the FS-4
directly to your camcorder using the optional camera mount
kit, or clip the FS-4 directly to your belt. The FS-4 is
designed to withstand the rigors of field shooting. The six
second electronic shock cache ensures your video is always
recorded even in the roughest of conditions.

Flexible Capacities and Power

The FS-4 comes with a 40GB (about 3 hours) hard drive.
Extend record times by linking two FS-4 units together.
Power the FS-4 using slim, removable battery packs or power
it using the supplied AC adapter.

Easy to Use, Control and Update

The FS-4 interfaces with your camcorder using a single
FireWire cable that passes audio, video, timecode and control
information. When a tape is present, each press of start and
stop on your camcorder's record button creates an individual
clip on disk. The FS-4 features a comprehensive backlit
display, menu system and buttons allowing easy control and
management. In addition, these units are upgradeable in the
field.

Never Miss A Shot

FireStore FS-4's six second retro record mode means you are

always recording. When action happens, you know up to six
seconds prior to the event occurring is saved in your clip.

FS-4 Pro Features

The FS-4 Pro offers these additional professional features:

Retro Disk and Loop Record modes

Scene Marking

This allows categorizing video clips into pre-named folders
on the disk during a shoot.

User definable 10-second retro cache record feature

User definable time lapse and loop playback modes
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* Pinnacle AVI and Avid DV-OMF support

* Available with either 40GB or 80GB hard drives with
equivalent record times of about 3 and 6 hours respectively.

* Free Run and Regen timecode modes

HD Features

FS-4 and FS-4 Pro recorders equipped with HD provide:

*  Support for cutting edge HDV camcorders with 720p and
10801 MPEG-2 capabilities equipped with a FireWire 1394
connection
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This section provides the following information necessary for using
the FS-4 as quickly as possible.

Physical Description and Basic Controls..............ccccccvvvvveeeen. 6
The FS-4 Menu System .......cceviiiiiii e 13
Connecting the FS-4 to AC Power ........ccccceevveveeiiiiiiiicins 16
Installing / Removing the Battery Pack ...........c.cccccceeenne 17
Connecting a FS-4 to a DV/HD Camcorder ..............cccuuu. 19
Record and Playback with the FS-4 ..............cocciiiis 20
Power Onthe FS-4 ... 20
Select HDD Recorder Mode ...........ooooiiiiiiiiiiiiiiiiiieeeeeeeee 21
Select a DV/HD File Format .........cccoocveiiiiiieiieee, 22
SetTime and Date ... 23
Record With the FS-4 ... 25
Manual ReCOrding .......ccoociiiiiiiiiiiiei e 26
Syncro Slave Recording ........ccoeeveeiiiiiiiiiiiiiiiieiceeee e, 27

Playback onthe FS-4 ... 28
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Physical Description and Basic Controls

Front Panel Controls
s p

LCD
Display

Function
buttons
FireStore FS-4
Navigation
Power ON —— T buttgns
Record
Button ~— | Transport
Control
buttons
Power OFF \Speaker
and
Stop button
LCD Display

This is a backlit, 14 character by 7 line dot matrix display.

Function buttons (A, B, C)

Below the FS-4 LCD display are three user-defined function
buttons: A (left), B (center), and C (right). Use them as short-cut
keys for the most frequently selected functions at the bottom of
the LCD screen. The function of these soft buttons changes,
depending on the options displayed above that specific button.
Refer to the “Functions Screen” on page 64 for more information.
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Power On Button

The Power ON button provides two functions.
¢ Power ON FS-4
* ResetFS-4

*  FS-4 first must be powered on.

¢ Hold down the Power On button for two seconds.
* Power OFF

Hold down the OFF button ® for three (3) seconds. During
power off, the FS-4 beeps, indicating that it is turning off.

Navigation Buttons

Use these buttons to navigate through the FS-4 menus. The
navigation buttons are Left, Right, Up, Down, and Select.

Transport Control Buttons

Record

SO S—
Forward
Back — =t S0 = =) — e

Search
] [ ]

?T =

!

Back STOP Forward
Index Power Off Index

Use these buttons to control FS-4 playback and record functions.
You usually operate these transport buttons while on the HOME
Screen.

Record e

Press this button once when the FS-4 is in Stop mode to put the FS-4
into REC-PAUSE. Press it again to start recording. Pressing the Record
button while recording, causes the current clip to close and a new clip is
created without dropping any frames. This button is the only button that
has a red legend on the front panel.
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Back Search €«

Press this button to play video at speeds different than real-time. Refer
to the note in the Forward Search paragraph.

Play »

Press this button to start playback of the selected clip.

Some HD Camcorders Require a Moment to Synchronize

Some HD camcorders require a moment to synchronize the video from an
external source. Typically during this period, they display a solid blue or
black video until synchronized.

Forward Search »»
Press this button to play video at speeds different than real-time.

Fast Forward and Reverse
Pressing the Forward Search button multiple times results in increases in
the search speed, i.e. fast forward. This mode works both in forward and
reverse functions. For instance, if you are in 10X FF speed and you press
the Back Search button once, the FS-4 is now in 2X FF mode. This applies
as well to backward search speeds. The default speed resolution is as
follows (NTSC and PAL have slightly different multiples for < 1X)

* Reverse: -30X, -10X, -2X, -1X (reverse play), -1/2X(-15fps), Still.

» Forward: Still, +1/2X (+15fps), +1X (play), +2X, +10X, +30X

Fast Forward and Reverse Compatibility
During Fast Forward and Reverse modes, some camcorders do not display
video when played-back from an external device, such as the FS-4 HD.

Back Index |4«

This button returns the FS-4 to the beginning of the current clip when in
playback mode. Press this button twice in sequence to return the FS-4 to
the previous clip during playback. In STOP mode, press this button to
return the FS-4 to the beginning of the previous clip.

Pause, Stop m and Power OFF

While in the Home screen, and in any transport mode, press this button
to Pause the FS-4. Press it again to stop the FS-4. Refer to the section,
“Setup Screens” on page 56 for more information.

To power off the FS-4, hold down the Stop button B for three seconds.
During power off, the FS-4 makes an audible beep indicating it is
turning off.

Forward Index »p|

Use this button to skip forward to the next clip in STOP and PLAY
modes.
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Top Panel
The top panel contains the following connectors and LEDs:
Remote Control Camera
(Serial Connector) (FireWire Connector)
Computer

(FireWire Connector)

Status LED
Charge LED >

Table 1: Charge LED States

LED Indicates

Off No Charger Connected

Green Charging Cycle Completed

Amber / Green Floating Charge Mode (Charging almost completed.)
Amber Fast Charge Mode (Maximum charging rate.)

Red Charging Error

Red / Amber No Battery Installed / Battery Error

Amber, blinking Insufficient Voltage to Charger

Table 2: Status LED States

LED Indicates
Off Power OFF
Green Power ON (Power On but there is no activity.)

Orange, solid Playback

Orange, fluttering Hard drive being accessed during playback.
Red, solid Recording Mode

Red, blinking Recording Pause
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Computer FireWire Connector

e In/Out: 6-pin IEEE-1394a port x 1
*  Asynchronous Data I/O

Remote Control, Serial Connector
e GPI/RS232C; 3.5mm TRS mini jack. (3.5mm to DB-9 cable
accessory available).
*  Change to act as a simple contact closure or RS-232C port.
*  Connect an optional wired remote commander.

Camera FireWire Connector
«  DV/HD Video I/O
*  6-pin IEEE-1394a connector

*  Isochronous 25Mb/s DV video 1/O
FS-HD supports 10801/720p video I/O when used with HDV
camcorders equipped with a 1394 connection.

e Embedded 2-ch (48kHz, 16-bit) or 4-ch (12-bit, 32kHz) audio

10
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Rear Panel

The rear panel contains the following important items:

r
—— Belt Clip Post
d FY®
Fan Intake — \J L
Vent \ (117 —— Battery
Do Not Block — Compartment
Latch
—— Battery
Compartment

Side Panel

The side panel contains cooling vents as illustrated below.

Cooling Vents
Do Not Block \

11
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Bottom Panel

The FS-4 bottom panel features a single 2-pin DC power connector.
Connect the supplied AC power adapter here.

i

DC
Power
Internal Connector
Speaker
Cooling Vent Cooling Vent
Do Not Block Do Not Block

Internal Speaker

An internal speaker provides alarms and audible feedback.

To disable the audible feedback, go to the Settings menu.
However, the power, temperature, and disk capacity alarms are
always active.

12
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The FS-4 Menu System

The FS-4 menu system provides access to all the functions available
in the unit. Each of the screens below (except the Welcome and Home
screens which come up automatically when the unit starts) are
accessed by pressing the Left or Right navigation buttons. The
functions of each of the selections on these screens is explained in
more detail in “FireStore Functions” on page 41.

Ohicte

Returning to the Top of Menu or Home screen
To get to the top of any menu, press the Left button. To get back to the
Home screen:

Highlight the screen title at the top of the screen.
Press the Select button.

Welcome

Only appears for several seconds upon power up.
Home

Gateway screen for all functions, it displays disk and
operational status.

Control

Contains the following selections:

* Local

« AV/C

*  Syncro Slave

* Tapeless

Play From

Provides lists to select play material from:

e Track List

* Reel List

Play

Contains the following Play selections:
* Play Clip

*  Loop Clip

* Loop All

«  Play All

Reels Screen Fs-4 Pro only

Allows selected clips to be marked for placement in
particular Reels Folders.

13
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Utilities

Contains the following disk and clip functions:

e Delete Clip

e Format

*  Repair Disk

*  Repair Clip

*  File Name

e Upgrade

e System Reset

+  Diagnostic

»  Status

FS-4 Pro provides the following additional functions:

*  Organize Reel

*  Organize OMF

*  Organize Pinnacle

Functions

Contains user definable function button selections. Changing
a setting with a Function button is identical to changing the
setting in its corresponding menu. Refer to “Functions
Screen” on page 64 for more information.

Setup

Contains the controls for setting and reviewing the FS-4
configuration:

*  Set Date (XX/XX/XX)

e Set Time (XX:XX:XX)

*  View Firmware Version

«  LCDLight ON

* LCDLight OFF

+ LCDLight AUTO

e Alarm ON
*  Alarm OFF
e Stop Frame
*  Stop Gray

*  Stop No Video

* EXT CTL OFF

e EXT CTL PAUSE

* EXT CTL FRAME DV mode only
« EXTCTL FILE

« TC EXT (external)

* TCRECRUN
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* TCDROP NTSC only

¢ TC NON-DROP NTSC only
 LCD Contrast

FS-4 Pro provides:

* TCFREE RUN

* TC REGEN (regenerate)

« TCSET
« UBSET
HDD Mode

Contains the following hard drive selections:

* DV Recorder

«  HD Recorder

* DD Drive

*  Use Ext. FS-4

DV or HD Formats

Following HDD mode is a menu of formats available for the
type recorder selected in HDD.

If DV Recorder was selected the following formats are shown:

« Raw DV
* AVITypel
«  AVIType2

e Canopus AVI

*  Matrox AVI

e Quicktime

e Quicktime 24P

24P AVI Type 2

FS-4 Pro provides:

*  Pinnacle AVI

*  Avid OMF

FS-HD versions provide the HD Recorder option when
selected, the format displayed is:

e  M2T

Record

Contains the following recording functions:
*  Normal Record

*  Retro Cache Record

FS-4 Pro also contains:

*  Retro Disk Record

*  Loop Record

15
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Powerlng the FS-4
The FS-4 operation without a battery installed.

To operate the FS-4 without a battery installed, connect the
unit to an AC power source.
* Before operating the FS-4 with battery power.

It is first necessary to fully charge the battery. An uncharged
battery, typically takes 2-3 hours to charge.

Connecting the FS-4 to AC Power

Attach the AC power cord to the FS-4 (with or without battery
installed). The FS-4 is immediately ready for operation.

To do this, connect the AC power as follows:

DC Power Port

Battery Pack DC Cable

Step 1:  Plug the cord from the power supply into the bottom of the FS-4.

Step 2:  Connect the line cord to the rectangular power supply
(International models only).

Step 3:  Plug the line cord or AC adapter into an electric outlet.

16
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Installing / Removing the Battery Pack

Installing a Battery

Latch Slot

Latch

2

Battery Gently press down
Latch Hook

Slide battery pack forward

=

" Battery Pack Guidesf/'

Step 1:
Step 2:

Step 3:

Step 4:

Place the unit, so that the battery compartment is up.

Position the battery pack, as shown above, so that the latch
hook is almost in the latch slot, and touching the floor of the
battery compartment.

Slide the battery forward while gently pressing down.
Feel the battery slide along guides and seat itself.
When seated, the battery latch clicks into place.

Removing a Battery

Step 1:
Step 2:

Step 3:

Slide the battery latch to the left and hold.

Apply backward pressure to the battery pack at the triangle/
arrow and gently slide the pack back about 1cm or 3/8”.

This is the reverse motion of inserting the battery.

Remove the battery pack.

17
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Charging the Battery

The battery begins charging anytime it is connected to AC power using
the AC adapter supplied with the FS-4. The charge LED lights when the
FS-4 is charging. For information on the charge LED, refer to the
subsection “Top Panel” on page 9.

Before the battery can be used it must charge until the battery status
LED indicates the unit is fully charged.

e The Charge LED on the top of the FS-4 lights to show the
battery is charging.

¢ Anuncharged battery takes 2-3 hours to charge with the unit
powered off.

e The battery provided with the FS-4 can supply power to the
unit for about 90 minutes while in continuous Record or
Playback mode.

* An optional high capacity battery capable of providing power
for almost three hours of continuous recording is available
from Focus Enhancements.

Using FireWire to Charge FS-4

It is possible to charge the FS-4 battery through the 1394 port on a computer
provided that the computer outputs at least 15V through the port. To
determine if this is possible, consult the computer’s specifications.

Battery Use

A Misuse can cause property damage and/or bodily injury such as burns
if a conductive material such as jewelry, buttons, or beaded chains
touch exposed terminals. The conductive material may complete an
electrical circuit (short circuit) and become quite hot. Exercise care in
handling a charged battery, particularly when placing it inside a pocket,
purse, or other container with metal objects.

Warning: Do Not Use Unapproved Battery Chargers
A Use of battery chargers not approved by Focus Enhancements could
cause the battery to catch fire or explode.

Use Only Original Focus Enhancements FS-BC Battery
Chargers
There are four versions of the FS-BC battery charger for use in various

parts of the world.
ASYF-0940-01 USA

ASYF-0941-01 Europe

ASYF-0943-01  United Kingdom

ASYF-0944-01 Australia
These optional battery chargers are available from either your local
dealer or online at the Focus Enhancements web store,
www.focusinfo.co/sales/store.
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Connecting a FS-4 to a DV/HD Camcorder

Before performing this procedure, make sure you have installed and
charged the battery, see “Installing / Removing the Battery Pack” on

page 17.
Step 1:

Step 2:

Step 3:

Step 4:
Step 5:

Connect the supplied Firewire cable to the “DV 1/0” connector
on the top of the FS-4. (Only one end will match the plug in the
FS-4.)

Locate the FireWire/DV/iLink (or similar) connector on your
video camera. It is located in different places depending upon the
brand of camera. If you are unclear of its location, consult your
video camera manual.

Ohicte

FS-4 Supplied with 6-pin to 4-pin FireWire Cable
Some camcorders require a 6-pin to 6-pin FireWire, 1394, cable
and the cable provided with the FS-4 will need to be replaced.

Connect the other end of the FireWire, 1394, cable to your video
camera.

Turn on the video camera.

Turn on the FS-4.

19
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Record and Playback with the FS-4

Before using the FS-4, set up the unit as outlined in the following

sections:
Power Onthe FS-4 ... 20
Select HDD Recorder Mode ............coooviiiiiiiiieieeeieeeeeeeea, 21
Select a DV/HD File Format ........cccooeeeeiiiiiii, 22
SetTimeand Date ........ccccveveeiiiiiiiiiiiiee e, 23
Record Withthe FS-4 ... 25
Manual Recording .........cccceiiiiiiiiiiiiiiieeeeee e 26
Syncro Slave Recording ..........ccooiueieieeiiiiiiie e 27
Playback onthe FS-4 ........cccoiiiiii e 28

The values set in these procedures are fixed and persist through
power cycles. To change them, repeat the steps outlined above.

Power On the FS-4

Step 1:  Press the Power ON button for two seconds and release it.

20

Power ON

—Navigation
Buttons

Transport
Buttons

OFF (STOP)
To power OFF,
hold down for 3-5 seconds.
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Step 2:  The Welcome screen appears and displays while the
FS-4 initializes. Each FS-4 model has a unique welcome screen.

FIRESTORE
FS-4 FireStore
PORTABLE Model
DTE RECORDER

Step 3:  When the Home screen appears, proceed, see “Home Screen” on
page 43 for more details.

[ ] STOP 1-
COUNTER am

00:00:14:02
DISK1 168 min

FS-4 Pro —p»—= REEL
Only SYNC DISP LOCK

Select HDD Recorder Mode

Step 1:  Press the Right navigation button two times until the HDD Mode
display appears.

HDD MODE

-DV RECORDER
HD RECORDER

DD DRIVE
USE EXT FS-4

Step 2:  Use the Down navigation button to highlight the recorder mode,
either DV or HD.

Step 3:  Press the Select button on the navigation buttons.
Step 4:  Press the Left button to return to the menu title.
Step 5:  Press the Right button once and advance to the FORMAT screen.
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Select a DV/HD File Format

The formats displayed depend on the recorder mode selected in the
previous step, for example DV RECORDER results in the following:

DV FORMATS
RAW DV

-AVl TYPE1
AVl TYPE2
CANOPUS AVI

Step 1:  Use the Up and Down navigation buttons to select the DV file
format that supports the preferred NLE system. A dash mark to
the left of a list item indicates that it is the current selection. The
default value is AVI Type 2.

DV24p and PAL 25p Modes
24p modes are only for use with camcorder's that are capable of
DV-24p Advanced mode.

PAL 25p camcorders require no special 25p DV format

Check www.FireStore,com for supported Applications

For a complete and up-to-date list of supported applications and
their associated formats, visit the website:
http://www.firestore.com

Step 2:  Press the center Select button on the navigation buttons.
Step 3:  Press the Left button to return to the menu title.
Step 4:  Press the Right button once and advance to the SETUP screen.
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Set Time and Date
Olate

Date and Time Must Be Set

The date and time must be set because they are used in the FS-4 file
naming function.

Step 1:  Press the Right navigation button several times until the Setup
display appears on the screen as shown below:

SETUP

09/15/05
11:21:13

V 1.0.0
-LCDLIGHT OFF

Step 2:  Use the Down navigation button to highlight the date and press
the Right navigation button to access the Set Date screen.

SET DATE

KX)/ 15/ 05

MM/DD/YY

BACK

Step 3:  Use the Up and Down navigation buttons to change the
highlighted value. Use the Right and Left navigation buttons to
highlight the Month, Day, and Year.

Step 4:  When complete, press the right-most Function button indicated
as BACK on the screen. The new date will be indicated on the
Setup Screen.

23



Quickstart

Step 5:  Use the Down navigation button to select the time and press the
Right navigation button. The following screen appears:

SET TIME

K 21:13

HH: MM : SS

BACK

Step 6:  Use the Up and Down navigation buttons to change the
highlighted value. Use the Right and Left navigation buttons to
highlight the Hour, Minute, and Second. (Time is indicated in
24hr. mode.)

Step 7:  Press the right-most Function button indicated as BACK on the
screen. The new date appears on the Setup Screen.

The Time and Date are now set.

Step 8:  Press the Left navigation button followed by the Select button to
return to the beginning screen.

For more information on the Setup function, refer to the section,
“Setup Screens” on page 56.
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Record With the FS-4

There are two modes of recording with the FS-4.

Manual Recording

Control with the FS-4 transport buttons.

Syncro Slave Recording or Tapeless Recording
Control recording with the video camera controls.

Before beginning recording, verify that:

1.
2.
3.

Time and date are set.
Recording format is set.

The FS-4 is connected to the video camera according to the
explanation in “Connecting a FS-4 to a DV/HD Camcorder”
on page 19.

Camera and FS-4 are powered on.

Tape is loaded in the camera.

Tapeless Operation
Tape does not need to be loaded if the camera supports tapeless
operation, refer to, “Control Screen” on page 83.

A Do Not Disconnect Power or FireWire Cable
Never disconnect the power or the FireWire cable during a
recording. This will cause file corruption.

Loss of Power During Recording

If power is lost during recording it is possible to repair the
damaged file or files, refer “Repair Disk” on page 72 to and
“Repair Clip” on page 73.
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Manual Recording

Step 1:
Step 2:
Step 3:

Record ® —

Step 4:

Step 5:

Step 6:

Step 7:
Step 8:

Set the video camera to Camera or Cam mode.
Verify that an image appears in the viewfinder.

On the FS-4, press Record ® once.
This sets the FS-4 to Record-Pause mode.

|
Stop W' (OFF)

On the FS-4, press Record ® button a second time. The FS-
4 begins to record. The timecode value is displayed on the
screen.

Press Stop ® (OFF) once to return the FS-4 to
Record-Pause mode.

Press Record ® and the FS-4 begins to record again on the
same clip.

Press Stop B (OFF) twice to stop the recording.
Press Record ® twice to begin recording a new clip.

Creating a New File without Dropping Frames

When in record mode, it is possible to break the recording into a
separate, new file without dropping frames.

Press Record ® and the FS-4 automatically creates a new clip.

Troubleshooting: Counter Not Incrementing
If the Counter does not increment while recording the camera, it is an
indication that there is no active connection between the FS-4 and the

camera.

+ Verify that the FS-4 1394 DV I/O and the camera connections are
secure. It may be necessary to unplug and then reconnect them.
When a good connection is made, the Counter will increment and recording

will start.



Quickstart

Syncro Slave Recording

Syncro slave recording allows the FS-4 to mimic camcorder
operations by monitoring the state of the camcorder’s tape
recorder controls.

Step 1: Verify that the FS-4 is in STOP mode.

Step 2: From the FS-4 Home screen, press the Right navigation
button several times until the Control screen appears:

CONTROL

LOCAL
AV/C

-SYNCRO SLAVE
TAPELESS

Step 3: Use the Down navigation button to select Syncro Slave.
The dash on the left side of an item indicates it is the current
selection. The default value is Local.

Step 4: Press the Select navigation button.

Step 5: The beginning screen returns and a Pause indicator
appears in the upper left-hand corner. Next to this symbol,
is a Y indicating that FS-4 is following the state of the
camcorder’s tape controls, i.e. record when the camcorder
records and pause when it pauses.

Step 6: Now the FS-4 will respond to the camcorder’s tape
controls. The recording signal goes both to the tape in the
camera and to the FS-4.

Recording Timecode in the File

Select EXT TC in the Setup menu. This option records the video camera
timecode in the file.

Function buttons

The tasks discussed above are available for programming into the function
buttons. For information on setting up function buttons, refer to the section,
“Functions Screen” on page 64
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Playback on the FS-4

Verify that both the video camera and the FS-4 are powered on and
that they are connected together with the FireWire cable from the FS-
4 DV/IO port to the camcorder 1394 port.

Feature Availability on PAL Cameras
This feature is not available on some PAL cameras.

Step 1:  Set the video camera to VCR or playback mode.

Step 2:  Navigate to the video clip to preview, using the FS-4 Left and
Right transport control buttons.

Play

e i———
—r =) ey — Forward

Back — T @
Search Search

Left Right
Transport Transport
(Back Index) (Forward Index)

Step 3:  Press the FS-4 Play button.

Step 4:  Search through the clips using the FS-4 Forward Search,
Forward Index, Backward Index, or Backward Search
buttons. Refer to “Quickstart” on page 5 for more information on
the function of these buttons.

Camcorder Compatibility with External Players
Some HD camcorders are not compatible with the external player
functions Forward/Reverse Search and Pause.
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Using the FS-4 with a Computer

Once video clips are recorded to the FS-4 it is possible to use those
clips in most computer based DV/HD NLE systems. This section
contains the following:

Initial SetuP ..o 30
Mounting the FS-4 in WindOws .........cccccvevveeeeiiiiiciiniieee, 30
FS-4 and FAT 32. ...t 32
Using Avid OMF Clips FS-4 Proonly ..............ccoeeccvivvvennnn.n. 33
Dismounting the FS-4 (WiNdOWS)..........cooiiiiiiiieiiiiiiieeeene 36
Mounting the FS-4 (Macintosh) ........ccccccccveeiiiiiiiiciiieee, 37
Dismounting the FS-4 (Macintosh) .........ccccooiiieiiiiiiiiencns 38

In the past, to get footage into an NLE system, it was necessary to
capture / digitize the footage using a video capture card. The FS-4’s
DTE functionality eliminates the capture stage. All that is necessary
is the moving of the video files from the FS-4 to a computer. To do
this:
e Connect the FS-4 directly to a computer with an active OHCI
compliant IEEE-1394 FireWire port and the necessary
FireWire disk drive drivers.

For More Information
Go to the Focus Enhancements' website (www.focusinfo.com) for
more compatibility information.

e Use the FS-4 HDD Bypass mode, refer to “Initial Setup” on
page 30 for more information.

The FS-4 is compatible with any computer system that can read
FAT 32 volumes, such as Windows 98SE/ME/2000/XP and Mac
0OS9/0S10.
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Initial Setup

Step 1:  Enter HDD mode and enable DD Drive.
This step is required before mounting the FS-4 to a computer.

* On the FS-4 go to the HDD screen.
+ Select DD Drive and Right arrow to Connect screen.
+ Press Enable function button.

Refer to the section, “HDD Mode Screen” on page 51

Step 2:  Connect the FS-4 through its COMPUTER 1/0O 1394 port to the
computer system using a standard 6-pin to 6-pin FireWire cable.

Step 3:  Connect power to the drive if necessary.

Step 4:  Consult the computer’s documentation for more information.

Mounting the FS-4 in Windows
Use this procedure for Windows XP, 2000, 98SE and ME.
Step 1:  On a Windows-based computer system, double click the My

Computer icon on the top left hand corner of the desktop. A
directory window appears.

My Computer =131 x|
File Edt View Favorites Tools Help |ﬁ
=Back - = - ‘ Qisearch [YyFolders 04 ‘ g X w | E-

Address I@, My Computer j e
Mame 4 | Type | Total Size I Free Space I

Blave Foppy ()| 3inch Floppy Disk

(=D Local Disk (C:) Local Disk. 5.85 B 1.56 GB

@Cnmpact Disc (0:)  Compact Disc

(=ILocal Disk (E1) Local Disk 13.2GB 10.4 GB

@Compact Disc (F:)  Compact Disc

S2public on 'Fst'{G:)  Mebwaork Drive S48 B 50,9 GE

PManuals on Fs1'{... Metwork Drive S48 GEB S0.9 GE

mMpegs on Fs1' (M:)  Metwork Drive 548 GB 50.9 GB

() contral Panel System Folder

(SIFSHPRO (I Local Disk. I7EGE 3T1GE

‘10 obiject(s) |@ My Computer 4

Step 2:  Locate the FS-4 drive and open it.

Often, it appears as a standard FireWire disk drive and may be
labeled E:, F:, G:, and so on.

Step 3:  Open the FS-4 disk icon.
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Using the FS-4 with a Computer

Open the folder with the most recent date code.

Fle Edt Vew Favores Took Help
Qe - © - B P semch [ rokes | 3 37 X 9 @
Address [ E:\ v|Bc
Name ~ Sze Type Date Modfied
@0 Fie Folder 7/14/2005 3:53 PM
o1 Fie Folder 7/14/2005 3:53 PM
@2 Fie Folder 7/14/2005 3:53 PM
a3 Fie Folder 7/14/2005 3:53 PM
@4 Fie Foider 7/14/2005 3:53 PM
&s Fie Folder 7/14/2005 3:53 PM
(=13 Fie Foider 7/14/2005 3:53 PM
a7 Fie Folder 7/14/2005 3:53 PM
@8 Fie Folder 7/14/2005 3:53 PM
29 Fie Folder 7/14/2005 3:53 PM
©220050803-164513-01 Fie Folder 8/9/2005 12:40 PM
a Fie Folder 8/3/2005 4:47 PM
) Desktop 0B 480KB Fle 7/14/2005 3:53 PM
[BDesktop OF 64K Fie 7/14/2005 3:53 PM

This folder may contain several different files. The video clips.

can appear as:

B¥ E:\20050803-164513-01
Fie Edit View Favortes Tools Hep

Qux - © B psearch [ Folders | [ (3 X ©) [+

Address |9 E:\20050803-164513-01 v Boo

\ 20050803-164654-01.dv I\ 20050809-123952-01
DV Fie MOV Fle
24,141 KB 63,104 KB
I\ 20050803-124027-01
MOV File
38,800 KB

* RawDV (.dv)
* AVIType 1 - (YYYYMMDDHHMMSSa01)

« AVI Type 2 or 24p AVI Type 2 - (YYYYMMDDHHMMSSb01)

* Canopus AVI - (YYYYMMDD-HHMMSSb01)

+ Matrox AVI - (YYYYMMDD-HHMMSSmO1
This file has a separate .wav audio file per track.

* QuickTime or 24p Quicktime (.mov)

FS-4 Pro

* Pinnacle AVI - (YYYYMMDD-HHMMSSp01
There are two separate .wav audio files per track.
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* Avid OMF (.omf)
OMF has two separate .aif audio files per track.

Ohote

FS-4 Pro Video Clips in Reel Folder

FS-4 Pro, permits the storing of video clips in either the
standard file folder or a Reel folder. If video clips have been
assigned to a Reel folder, it is necessary to run Organize
Reels before attaching the FS-4 to a computer.

FS-HD Resolution and Frames

e M2T filename format: YYYYMMDD-HHMMSSX01.m2t where
the X is a letter indicating the resolution of the captured video file.
The table below lists letters and associated resolutions. Not all
HDYV camcorders support these resolutions.

X Resolution X Resolution

d 720p, 23.976 fps D 1080i, 23.976 fps
b 720p, 24 fps B 1080i, 24 fps

¢ 720p, 25 fps C 1080i, 25 fps

a 720p, 29.97 fps A 1080i, 29.97 fps
e 720p, 30 fps E 1080i, 30 fps

f 720p, 50 fps F 1080i, 50 fps

g 720p, 59.94 fps G 1080i, 59.94 fps
h  720p, 60 fps H 1080i, 60 fps

z 480p, 60 fps

FS-4 and FAT 32

The FAT32 file system limits file size to a maximum of 2GB or
approximately, 9 minutes of recording time.

When clips exceed 9 minutes in length, the FS-4 automatically
creates a new, file without dropping any frames. The two files have
the same root filename but have different two digit suffixes that
indicate the order of their creation, -01, -02, and so on. This process
can produce as many sequential 2GB files as the drive can hold.

With most NLE systems on a Windows computer, it is possible to use
clips within the timeline. Select the clips on the source volume, i.e.
the connected FS-4, and import them directly into the NLE bin.
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This makes clips immediately available in the NLE timeline.

The high transfer speed of the FS-4 drive permits direct streaming of
the clips to the NLE, thus eliminating the need to copy or transfer the
clips before their use.

Using Avid OMF Clips FS-4 Pro only

These steps are required when using Avid OMF formatted clips.

The Avid DV OMF file format was developed for use with Avid
editing products on Windows 2000, Windows XP or Mac 0SX. These
products include Avid Xpress Pro, NewsCutter, and Media Composer
Adrenaline (with the DV option).

The Avid DV OMF file format creates three files simultaneously; one
OMF video file and two separate AIF audio files. On the computer's
desktop, the files appear similar to those shown below.

CON—— kol
Fl= Edt Wew Favorfes Toos  Heip "
LS R b2

On the FS-4, the video file (OMF) and the audio files (AIF) appear as
one track.

When an Avid DV OMF file is deleted, the FS-4 deletes the audio and
video portions at the same time.
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To use a FS-4 recorded Avid DV OMF file on an Avid NLE system,
use the following procedure.

ORGANIZE OMF Function
If using the ORGANIZE OMF function on the FS-4 before connecting it to a
computer, steps 2 and 3 are not necessary

Step 1:
Step 2:
Step 3:
Step 4:

Step 5:
Step 6:

Step 7:
Step 8:
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Locate and open the FS-4 drive folder.
Create a new folder and name it OMFI MediaFiles.
To do this in Windows, select File>New>Folder .

To do this with Macintosh, select File>New Folder. Next,
type OMFI MediaFiles.

Drag all the OMF and AIF files into the new folder:
Do Not Drag in the files titled Desktop DB or Desktop
DF.

Launch Avid.
Open an existing project or create a new one.

Select Tools>MediaTool. A screen similar to the
following appears:

= @ venr (s
@& . Frecengns (i
Bl _ vessFies




Step 9:

Step 10:

Step 11:
Step 12:

Step 13:

Using the FS-4 with a Computer

Locate and select the FS-4 under Media Drive(s).

If Drive Does Not Appear

If the drive does not appear, check to make sure that the
OMFI MediaFiles folder was created correctly with proper
case and spacing.In addition, verify that the drive is properly
connected and recognized by the computer. Under
Project(s), select All Projects (This highlights all items in
the Project(s) window).

Verify that Master Clips is checked and press OK. The
Media Tools Window, similar to the following, appears:

NP

T CTVRRC T U T 4
=

g Tracks et Erd Cospimn ar|
L §

B LB ] d ] L
B eXEiarsaran wviand nassaw nadagt o
T INEM-1ITE WAlD F424EE ZA14YTRH Lol &L

*

| TR | ——— -
T R A A AANNNNNRRNPLNPRSESSESS DG,

Create a new bin (select File -> New Bin) or open an
existing bin in Avid.

Select all items in the Media Tools window (select Edit>
Select All).

Drag the contents of the Media Tools Window into the bin.
It is now possible to use these clips in the Avid timeline.
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Using the FS-4 with a Computer

Dismounting the FS-4 (Windows)

When finished working with the FS-4 and the computer, it is
necessary to dismount FS-4 from the system

A Dismount FS-4 Before Powering Off
It is important to dismount the FS-4 from the Windows system
BEFORE powering down the unit.

To do dismount the FS-4:

Step 1:  Click the Safely Remove Hardware icon at the bottom right side
of the Windows task bar as shown below.

§M%  12:13PM

Unplug or Eject Hardware Icon J
(Safely Remove Hardware)

Step 2:  Next, the computer system prompts to Remove the connected
FS-4. This begins the dismount process.

Step 3:  Select the message and click on it.

The computer dismounts the FS-4 and then displays a message
that it is now safe to remove the unit.
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Mounting the FS-4 (Macintosh)

Step 1:

Step 2:
Step 3:

Start the Mac computer and connect the FS-4’s COMPUTER I/0
port to the computer using a standard 6-pin to 6-pin FireWire
cable.

When mounted, the FS-4 should appear on the computer's
desktop as shown below:

M = ) Fri8:56AM |

F5083004

The FS-4 appears as a FAT32 volume with a PC label. This is not
always the case on Mac OSX however.

Locate the FS-4 on the desktop and open it up.

Open the folder with the most recent date code (for example,
“20050127-110345-017). It should look similar to the
following:

|~ 20030831-072915-01

Q- local disks

@ Network - - i
@ 20030831-072917-01.mov
g Macintosh HD @ 20030831-073322-01L.mov
g FS083004 & [@ 20030831-073457-0L.mov
@ 20030831-073505-01L.mov
u Desktop @ 20030831-073508-01.mov
@ 20030831-073514-01L.mov
Q‘ mattmeewen H
:/ég Applications
ﬁ Documents
-
- Movies
& Music
gj Fictures
3

6 items, 35.75 GB available

Before Connecting FS-4 Pro to a Computer
If clips have been assigned to a Reel folder: perform an Organize
Reels before connecting the unit to a computer.
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Dismounting the FS-4 (Macintosh)

When finished working with the FS-4 and the Macintosh it is
necessary to dismount the unit from the system.

A Dismount FS-4 Before Powering Off
It is important to dismount the FS-4 from the Mac system
BEFORE powering down the FS-4.

To dismount the FS-4 from a Mac:

Step 1:  Select the FS-4 on the computer's desktop. It is marked with a PC
symbol.

Step 2:  Drag the drive into the trash or use the eject button. This
dismounts the particular disk drive.

Step 3: It is now safe to remove the FS-4.
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Mounting Hardware

Mounting FS-4 to a Camcorder

Mount the FS-4 to your camcorder using the optional Camcorder
Mount Kit (P/N ASYF-0849-01). For more information about this kit
or to order it, contact Focus Enhancements:

Office Hours: Monday through Friday
8:00 AM to 5:00PM (Central Time)

Email: support@focusinfo.com
Telephone: 763-398-1658

Fax: 763-571-7688

Address: Focus Enhancements, Inc.

1370 Dell Avenue
Campbell, CA. 95008
www.focusinfo.com

Clipping to a Belt

Belt Mount Clip
Front View Side View

FS-4
Belt Clip Post

A belt mount clip is included with the FS-4. This mount is similar to
those used with cellular telephones. Attach the belt mount to the belt
clip post on the rear of the FS-4 and push it down to lock it in
position.
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FireStore Functions

This section contains information on the following LCD screens:

General Screen Information ...........ccccccciiiiiieiii e, 42
ReCOrd SCreens ......cccoeoeiiiiiiiiii e, 46
HDD MOAE SCreEN ....ovveiiiiieeee et 51
FOrmat SCreen ..., 54
HD Format Screen FS-4 HD and FS4 Pro HD only ............ 55
Setup SCreens ....ooooiiii e 56
FUNCtions SCreen ........ooovvviiiiiiiii e 64
ULilities SCreen ..., 68
Control SCreeN .....ccooeiiee e 83

FS-4 screens are organized in a flat hierarchy. Every screen has a
unique name, and it is possible to cycle continuously through the
screens using the Left and Right navigation buttons.

Use the Up and Down navigation buttons to cycle through screen
items (selections).

Use the Select Navigation button to make a choice.

Navigation Tip: Jump to Top of Display Using the Left Button

When navigating through the LCD displays and scrolling down into the
menu, press the Left navigation button on the front panel and immediately
return to the top of the display, which allows navigating to other displays.
Jump to Home display Using Select Button

To return immediately to the Home Screen, navigate to the menu title at the
top of the screen and press the Select button.

41



FireStore Functions

General Screen Information

The FS-4 LCD screens are organized by function with each screen
displaying a list of items. An item can be:

e A value that can be set, such as the date.

* A switch similar to a check box, that can be enabled along
with other options in the display.

* A switch similar to a radio button, that belongs to a family of
options, in which only one can be active at any time.

* A link to another display, which is indicated by a p>.

SETUP Menu Title
Appears at the top of the

01/16/06 ?iSPlay ?nd itqentiﬁes its
09:30:19 opic or function.

V1.0.0
-LCDLIGHT ON

Navigation

Use the Left or Right Use the Up and Down
navigation buttons to move navigation buttons to move
to the previous or next between the items in the
display. display.

Welcome Screen

The Welcome screen appears briefly after boot-up, and automatically
switches to the Home screen when the FS-4 is ready for operation.

FIRESTORE
FS-4 Varies
PORTABLE depending on
DTE RECORDER the FS-4 Model
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Home Screen

The Home screen is read only and has no items to navigate to. To
leave the Home screen use either the Left or Right Navigation button.

1 2

. STOP 1-
COUNTER

12— 00:00:14:02 ll
| DISK1 168 min <-— 6

10— REEL
FS-4 Pro ISY¢NC DISP LOCK
7

9

47- 3
il 4

1. Current Function: Symbol and Description
Refer to “LCD Display Symbols and Text” on page 85.
2. Volume Disk Number

The volume number is always 1 unless multiple FS-4’s are
connected.

3. Clip Number
Number of the current video clip, i.e. 001 for clip 1.
4. Battery Life Gauge
This gauge is accurate only when the unit is powered
exclusively from the battery.
5. Timecode Value

Either Drop Frame - 00;00;00;00 or, Non Drop Frame -
00:00:00:00.

6. Time remaining on the disk.

7. FA Functions with SYNC as the default, refer to “Functions
Screen” on page 64 for more information.

8. FB Functions with DISP as the default, refer to “Functions
Screen” on page 64 for more information.

9. FC Functions with LOCK as the default, refer to “Functions
Screen” on page 64 for more information.
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10. Reel Display FS-4 Pro only

In Record or Playback modes, this item displays the particular
REEL that a clip is located in or, has been marked to. If in
PLAY FROM > REEL LIST mode, the REEL appears in
brackets for example, <REEL>. This area is blank if NO
REEL has been selected.

11. DISP information field that displays data type.

12. DISP information field that displays current data.

DISP (display) Information Fields

Use the DISP function button to display current operation
information fields 11 and 12. The data shown depends on the
mode of operation, i.e. DV or HD Recorder.

Pressing the DISP button advances the display to the next
category of information. Below is a table of the data types and
data available with DISP.

Field Data Type /
Number Data Description
11 COUNTER
12 Shows frame count of current video clip during record or
playback.
11 REMAINING
12 Record: counts down number of available frames

remaining, as time, on a specific disk.
Playback: displays time remaining of the current clip.

11 DV (NTSC or PAL) or HD (see note following table)

12 Record: displays the external timecode value being
generated by a camcorder or other device during a
recording session. Timecode mode must be set to EXT
TC for this function to operate, refer to “TIME CODE
EXT, REC RUN, FREE RUN, REGEN" on page 60.
Playback: displays the embedded DV timecode value in
a particular track.

1 UB NTSC

12 Displays the set user bit value in a particular clip. A user
bit value must be added for this to display, refer to “UB
SET FS-4 Pro only” on page 62.
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11 ABSOLUTE

12 Displays an absolute timecode value for the particular
session: the sum of all COUNTER timecodes on
connected volumes.

Absolute is primarily used when setting the FS-4 to AV/C
mode and controlling it with an external FireWire device,
such as a computer.

DV (NTSC or PAL) and HD

The information displayed in fields 11 and 12 depends, in part, on which
Recorder Mode is set.

DV RECORDER

Line 11 displays the Standard Digital (SD) video format. It can not be
changed.

HD RECORDER

Line 11 displays the HD resolution of the current track which depends on
the camcorder in use with the FS-4 HD unit. Possible values are:

» HD 1080/50i TC
« HD 1080/60i TC
» HD 720/30p TC
* HD 720/25p TC
» HD 720/24p TC
» HD 720/50p TC

+ HD 720/60p TC
Refer to the camcorder manual for supported resolutions.

FS-4 System Information Screens

The FS-4 automatically creates information screens to indicate
conditions such as high temperature, power remaining, or drive
capacity remaining.

WARNING

5%
POWER

REMAINING

Press OK to clear the screen and return to the last screen.
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Record Screens

NORMAL
-RETRO DISK

RETRO CACHE
LOOP RECORD

The Record screen permits setting the FS-4 to various recording
modes, depending on the model:

* NORMAL

¢ RETRO DISK Fs-4 Pro only

* RETRO CACHE

e LOOP RECORD Fs-4 Pro only

e  SNAP Fs-4 Pro, DV modes only

¢ TIMELAPSE Fs-4 Pro, DV modes only

Once a record mode is selected, the recorder remains in that mode
until a different mode is chosen. Exiting the Record screen and
returning to Home, enables the selected recording mode.

To verify that the digital recorder is set to the correct recording mode,
refer to the upper left-hand of the Home screen where the recorder
mode is displayed.

Record Mode Indicator
(Retro Cache)

Symbol Indicates Notes
L Retro Disk FS-4 Pro only
C Retro Cache
o Loop Record
SNAP Snap Record FS-4 Pro only
T Timelapse FS-4 Pro only
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For more about LCD display symbols and text, see “LCD Display
Symbols and Text” on page 85.

Normal Record

This is the standard recording mode.

e All control is from the FS-4 front panel.
Initially, the Home screen displays m STOP.

* Pressing Record @ puts the FS-4 into Il REC PAUSE mode.

* Pressing Record @ a second time puts the FS-4 into REC
mode.

Retro Cache Record Mode

:00
:SS <«———This line is not active:
reference only.

The Retro Cache mode insures that important material at the very
start of a recording session is captured. Retro Cache stores in the on
board memory a continuous loop of video captured by video camera
during pauses. Pressing Record @ begins active recording at the last
frame stored in the cache. The resulting video clip has the cached
video at the beginning.

Retro Cache is available in Local, Syncro Slave, and Tapeless Trigger
control modes.

FS-4 non-Pro

Settings enable or disable the Retro Cache. When enabled a fixed 6
seconds of video is cached.

FS-4 Pro

Set the length of video that the Retro Cache should store: 0 to 10
seconds.
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Retro Disk Record Mode FS-4 Pro only

HH:MM -a——;— This line is not active:
reference only.

The Retro Disk mode records video in a continuous loop to a
user-defined portion of disk space. Pressing Record ® seamlessly
begins active recording. The Retro Disk session is appended to the
beginning of the new clip. The result is a set of clips beginning with
the cached video and continuing with the newly recorded video.
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When calculating the amount of hard disk space needed for a

Retro Disk record session, always include additional space

beyond the recording requirements. The added space depends

on the length of the loop.

*  Loops less than 60 minutes, need an additional 1 minute of
unused disk space.

*  Loops 60 minutes and greater, require an additional 9 minutes
and 13 seconds of unused disk space.

When looping less than one hour, Retro Disk records the

loop in a series of 1 minute clips.

Retro Disk is available in Normal, Syncro Slave and Tapeless
control modes.

When Retro Disk is set, the symbols eL (Record and L)
appear in the FS-4 Pro display.
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Loop Record FS-4 Pro only

Loop Record is similar to Retro Disk.

Loop Record continuously records a series of video clips to available
disk space. When all available disk space is used, Loop Record
begins sequentially replacing the earliest clip with the most recent.

*  The size of the video clip depends on the length of the loop.

*  Loops of 60 minutes or less are recorded in one-minute clips.
*  Loops greater than 60 minutes, are recorded in 2GB clips.

*  When the capacity of the disk is reached, one additional clip is
created. The size of the last clip depends on the length of the
loop i.e., one-minute or 2GB. The disk must have at least 30
minutes of disk space available for this functionality.

Saving Loop Record Clips
Press STOP during a record session.

The FS-4 stops recording and saves the current LOOP RECORD
session clips to a folder on the disk.

Snap Record FS-4 PRO, DV modes only

Use Snap to record individual frames. In Snap mode, pressing
Record @ captures a single frame.
*  Snap Record is available only in DV modes of operation.
* Use Snap in Local, Syncro Slave, and Tapeless control modes.
* Removing power from the FS-4 Pro in the midst of a Snap

recording session causes the FS-4 Pro to return to Normal
recording mode when it powers back up.

Ohote

Another Method to Capture Single Frames
An alternative to Snap is EXT CTL FRAME. For more information see
“EXT CTL OFF, Pause, Frame, File” on page 59.
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Timelapse Record FS-4 Pro, DV modes only

00:00:00:00

HH:MM:SS:FF <«—3——This line is not active:
reference only.

Timelapse provides the ability to record a single frame at specific
time intervals, for example one frame per minute, 00:01:00:00.
Timelapse applications can include capturing the traffic on city
streets, the growth of a plant from seed to maturity, and construction
projects.

Features of Timelapse function include:
* Al the captured frames are recorded in a single clip.

*  The time between recording periods can be set in frames,
seconds, minutes, and hours.

¢ The maximum time between recorded frames is 24 hours.
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HDD Mode Screen

-DV RECORDER
HD RECORDER

DD DRIVE
USE EXT FS-4

Depending on the product, this screen displays the following items:

DV RECORDER

This sets the FS-4 as a DV recorder.

Connect the camera to the FS-4 DV 1/O port using a FireWire
cable.

HD RECORDER Fs-4 HD AND FS-4 Pro HD only

This sets the FS-4 as an HD recorder.

Connect the camera to the FS-4 DV 1/O port using a FireWire
cable.

Recording in this mode only works with HDV camcorders
that have a 1394 FireWire connector and that support an HD
resolution, such as 1080i or 720p.

Switching Between Recorder Modes (DV and HD)
Switching between recorder modes resets the Record Mode to Normal, see
“Normal Record” on page 47.

DD DRIVE >

Use this option when connecting the FS-4 to a computer. The
FS-4 functions as a volume visible to the computer. In
addition, this setting permits the connecting of multiple FS-4
together to increase recording space.
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USE EXT FS-4

Use this option when longer recording times are needed. USE
EXT FS-4 permits the connecting of two FS-4 together to
provide more disk storage for longer recording. One unit acts
as the master with the other as a slave: the master records to
itself until full and then continues recording on the slave unit.

Identifying Master/Slave Volumes During Record/Playback

When two FS-4s are in combined via USE EXT FS-4 and in either
Record or Playback mode, the volume on the Home screen will
display 1-xxx when the master unit is recording or playing back and 2-
xx if it is the slave.
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Setting Up Master and Slave FS-4

Step 1:

Step 2:

Step 3:

Step 4:

Step 5:

FireStore FS-4

Connect the camcorder to the master FS-4, DV I/O connector
using the supplied FireWire cable.

Master
Power on unit.
Go to the HDD Mode menu screen and enable USE EXT FS-4.

Slave
Power on the unit
Go to the HDD Mode screen and enable DD DRIVE.

Connect the FS-4s through their Computer I/O connectors using
a 6-pin to 6-pin FireWire cable.

Master
Begin recording or playback using the master FS-4.

A Use DD Drive Mode when Connecting to a PC
It is important to take the master FS-4 out of USE EXT FS-4
mode before attempting to connect to a computer.
To do this, select DD DRIVE from the HDD Mode screen.
This returns the unit to hard disk mode.
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Format Screen

DV Formats

AVITYPE 1

AVI TYPE 2
CANOPUS AVI

DV formats include:

¢« RAWDV

e AVITYPE1

e AVITYPE 2

¢ CANOPUS AVI

¢ MATROX AVI

*  QUICKTIME

e AVID OMF FS-4 Pro only

*  QUICKTIME 24P

e AVITYPE 2 24P

e PINNACLE AVI FS-4 Pro only

Using Organize PINN and Organize OMF

AVID OMF and PINNACLE AVI formats require using the Utilities functions,
Organize PINN or Organize OMF respectively. Refer to the section, “Utilities
Screen” on page 68.

Formats for 25P Applications
Use standard file formats for all 25P applications except AVID OMF. OMF is
not compatible with 25P DV streams.

The latest DTE supported applications and file formats are listed on
the Focus Enhancements website: www.focusinfo.com.
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HD Format Screen FS-4 HD and FS4 Pro HD only

The latest DTE supported applications and file formats are listed on
the Focus Enhancements website: www.focusinfo.com.

Check regularly for updates.
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Setup Screens

10/10/05
21:10: 50

vV 1.0.0
-LCDLIGHT ON

The items on the Setup Screen are grouped by function. Within the
function the items act like radio buttons, i.e. when one is active the
others are not.

In some cases, such as the Date, a settings screen appears. To return
from a settings screen, use the BACK function button.
The items displayed on the Setup screen include:

¢ DATE Displayed p>

e TIME Displayed p>

¢ VERSION Displayed p»

e LCDLIGHT ON Group Default
e LCDLIGHT OFF
e LCDLIGHT AUTO

e ALARM ON Group Default
e ALARM OFF

¢ STOP FRAME; (1st frame of current clip) Group Default
¢ STOP GRAY
¢ STOP NO VIDEO

e EXT CTL OFF Group Default
e EXT CTL PAUSE

e EXT CTL FRAME

e EXTCTLFILE
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e TC EXT Group Default

¢ TCRECRUN

e TC FREE RUN Fs-4 Pro only
¢ TC REGEN Fs-4 Pro only

e TCSET p Fs-4Proonly

e UBSET p Fs-4Proonly

e TC DROP NTSC only
¢ TC NON-DROP Default, NTSC only

e LCD CONTRAST
Olote

Date and Time Must Be Set

The date and time must be set. They are used in the FS-4 file naming function.
Refer to “Set Time and Date” on page 23.

Date
SET DATE
09/18 /05
MM /DD /YY
BACK
Time

SET TIME
10 : 50 : 40

HH: MM : SS

BACK
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Version

1. 0. 01234567
NTSC

FS-4 PRO HD

This screen displays:
¢ FS-4 Firmware version
e SD video of the unit.
*  FS-4 model

LCD Light ON, OFF, AUTO

These items enable or disable the FS-4's LCD's backlight.
e LCDLIGHT ON Group Default

Keeps the backlight on permanently.
e LCDLIGHT OFF

Keeps the backlight off permanently.
* LCDLIGHT AUTO

Turns off the backlight after one minute.

On the FS-4, pressing any button pad button turns the backlight back
on.

Any information screen turns the backlight on.

Alarm ON, OFF

Default is On.

*  When the alarm is enabled, pressing any button on the FS-4
produces audio feedback.

*  The FS-4 alarm triggers when conditions such as low battery
charge, low disk space, or over heating occur.
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¢ When Alarm is set to Off, the audio feedback for the buttons
is disabled, however the alarm will still sound for low power,
high heat, or low disk space conditions.

Stop Frame, Gray, No Video

¢ STOP FRAME Group Default

Displays the first frame of the clip.
¢ STOP GRAY

Displays a black frame.
e STOP NO VIDEO

Video output is Off.

EXT CTL OFF, Pause, Frame, File

These options permit the use of an external device to control the FS-4
through the optional RS-232 cable.

Ohote

RS-232 Cable Available from Focus Online Store

The RS-232 cable required to connect the FS-4 to an external control device
is Focus part number CBLA-0114-01. It and other accessories mentioned in
this manual are available at https://www.focusinfo.com/sales/store.

« EXT CTL OFF
Use this option when connecting an external device with an
RS232C cable.
*  This requires the use of a a 3.5mm-to-DB9 adapter cable,
plugged into FS-4 Control port.
In Local mode, select this item to control the FS-4 with the
optional wired remote control unit, refer to page 83.

The following options permit control functions to occur from a
simple contact closure.
e EXT CTL PAUSE
Controls Pause and Resume during a record or playback
session.
e EXT CTL FRAME DV Mode Only
Captures a single frame of video and records it to a file. Each
time this function is triggered, it sequentially adds another
frame to the same file until stopped.
e EXTCTL FILE
Creates a new file during a record session without losing any
frames.
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TIME CODE EXT, REC RUN, FREE RUN,
REGEN

The following are timecode (TC) functions.

Ohote
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TC EXT Group Default

Records the incoming source timecode. If the timecode is not
running, and the FS-4 records the same timecode number in
each recorded frame. Choose TC EXT mode to clear any
stored number.

TC REC RUN

This function creates a time code number for the first frame
of the next recording. To do this it can either:

« FS-4
Take the last timecode recorded and add 1,
* FS-4Pro

Use the value stored in TC SET.

The FS-4 stores the last recorded timecode in its non-volatile
memory, so it can persist across recording sessions.

TC FREE RUN Fs-4 Pro only
This function causes the FS-4 Pro to begin counting from the
value stored by TC SET.

* A number entered through TC SET is not stored and available
to the FS-4 until exiting TC SET. Only then does the FS-4 Pro
begin counting using that number.

TC REGEN Fs-4 Pro only

When the FS-4 Pro powers up in TC REGEN mode, it:

¢ Reads the timecode of the last track recorded.

¢ Adds 1 to the number.

»  Stores the new timecode as the number that will be assigned to
the first frame of the next recording session.

If the drive is empty, i.e. no existing recordings, the

FS-4 Pro uses the TC SET value.

TC SET and UB SET Can Be Set at the Same Time
Both parameters, TC SET and UB SET, may be set and are not mutually
exclusive as in some groups, i.e. LCDLIGHT.
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TC SET FS-4 Pro only

TC SET

00 :00:00:00
HH:MM:SS:FF

The Timecode Set parameter stores a user defined timecode in the
FS-4 Pros’s non-volatile memory. This value is available for use by
the FS-4 Pro immediately after exiting TC SET.
¢ TC FREE RUN Fs-4 Pro only
The FS-4 Pro uses this value on the next recording after it is
set in TC SET.
¢ TC REGEN Fs-4 Pro only
This is the starting value when using an empty hard disk
drive for recording.
e« TCRECRUN

This is the value used to begin every recording session.
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UB SET FS-4 Pro only

UB SET
FF : FF : FF : FF

The User Bit Set function provides the ability to change the user bits
in the timecode recorded in the video files.

*  Timecode values are not set when in TC EXT mode.

Professional applications employ user bits to add metadata to
recordings to assist in post production. For example, multiple
cameras are used during a shoot. Each FS-4 Pro has a unique UB
setting that identifies it and the camera it serves. Later, the user bits
are used to determine from which camera station the footage was
recorded.

62



FireStore Functions

TC DROP, NON-DROP NTSC only

These parameters are only available for NTSC and only one may be
enabled at a time. Drop and non-drop enable and disable the drop-
frame function that modifies how the timecode is calculated during
recording.
¢ TC DROP Group Default
Enables the drop-frame function and frames 00 and 01 are
dropped from each minute of video recorded.
* TC NON-DROP
Disables drop-frame. No frames are dropped during

recording and the timecode reflects the actual time during
recording.

LCD CONTRAST

SET CONTRAST
VALUE: 00

Use this function to adjust the contrast of the LCD display for easier
viewing.

Step 1:  Use the Right navigation button to go to the SET CONTRAST
submenu.

Step 2:  Use the Up and Down navigation buttons to increase and
decrease the contrast number.

Step 3:  Press BACK when done.
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Functions Screen

The Functions buttons FA, FB, and FC provide convenient Home
screen shortcuts by acting as toggle switches for specific system
settings. The Home screen below is an example of the information
displayed.

= STOP 1-

COUNTER K |
00:00:20:15
DISK 1 168 min

Reel receiving —— = R1
clips. DISP DD

Function Keys

FA FB FC
Function Groups

Function settings are user-assignable and available in the Functions
screen. Changing a setting with a Function button has the same effect
as manually changing the setting.

FUNCTIONS

-FA SYNC
FAAV/C

FA TAPELESS
FA REELS

*  There are three groups of functions FA, FB, and FC displayed
via the Functions screen.

*  The function groups are independent of each other.

* In each group only one selection is active at a time.
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Functions List

A list of the Function button menu is below. In each group, the default
selection is listed first.

MENU Appears on LCD as...

FA SYNC SYNC
Toggles between SYNCRO and NORMAL record control. Default

FA AV/C AV/C (Toggles between AV/C and NORMAL control)

FA TAPELESS TAPE (Toggles between TAPELESS TRIGGER and NORMAL
control)

FA REELS Increments current reel number, FS-4 Pro only

FA RO-0 Marks Clip 0 to Reel 0, FS-4 Pro only

FA R1-1 Marks Clip 1 to Reel 1, FS-4 Pro only

FA R2-2 Marks Clip 2 to Reel 2, FS-4 Pro only

FA R3-3 Marks Clip 3 to Reel 3, FS-4 Pro only

FA R4-4 Marks Clip 4 to Reel 4, FS-4 Pro only

FA R5-5 Marks Clip 5 to Reel 5, FS-4 Pro only

FA R6-6 Marks Clip 6 to Reel 6, FS-4 Pro only

FA R7-7 Marks Clip 7 to Reel 7, FS-4 Pro only

FA R8-8 Marks Clip 8 to Reel 8, FS-4 Pro only

FA R9-9 Marks Clip 9 to Reel 9, FS-4 Pro only

FA LCD ON/OFF

LCD On/Off Toggle

FA LCD AUTO LCD Auto On/On Toggle

FA BLANK No Function.

FB DISP DISP (Toggles the different TC display modes) (Default)

FB ALARM Turns the FS-4 alarm on or off.

FB FILE FILE (Toggles between normal and display of the file name)
FB REELS Increments current reel number, FS-4 Pro only

FB R0-0 Marks Clip 0 to Reel 0, FS-4 Pro only

FB R1-1 Marks Clip 1 to Reel 1, FS-4 Pro only

FB R2-2 Marks Clip 2 to Reel 2, FS-4 Pro only
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FB R3-3 Marks Clip 3 to Reel 3, FS-4 Pro only

FB R4-4 Marks Clip 4 to Reel 4, FS-4 Pro only

FB R5-5 Marks Clip 5 to Reel 5, FS-4 Pro only

FB R6-6 Marks Clip 6 to Reel 6, FS-4 Pro only

FB R7-7 Marks Clip 7 to Reel 7, FS-4 Pro only

FB R8-8 Marks Clip 8 to Reel 8, FS-4 Pro only

FB R9-9 Marks Clip 9 to Reel 9, FS-4 Pro only

FB BLANK No Function.

FC LOCK Locks the buttonpad (Default) - toggles between LOCK and UNLC
<Unlock>

FC DV/HDD Toggles FS-4 between DV/HD and HDD Modes

FC REELS Increments current reel number, FS-4 Pro only

FC R0O-0 Marks Clip 0 to Reel 0, FS-4 Pro only

FC R1-1 Marks Clip 1 to Reel 1, FS-4 Pro only

FC R2-2 Marks Clip 2 to Reel 2, FS-4 Pro only

FCR3-3 Marks Clip 3 to Reel 3, FS-4 Pro only

FC R4-4 Marks Clip 4 to Reel 4, FS-4 Pro only

FC R5-5 Marks Clip 5 to Reel 5, FS-4 Pro only

FC R6-6 Marks Clip 6 to Reel 6, FS-4 Pro only

FC R7-7 Marks Clip 7 to Reel 7, FS-4 Pro only

FC R8-8 Marks Clip 8 to Reel 8, FS-4 Pro only

FC R9-9 Marks Clip 9 to Reel 9, FS-4 Pro only

FC BLANK No Function.
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Assigning Clips to Reels

COUNTER _Eiﬂ
00:00:20:15 -
DISK 1 168 min

Currently —» R1
Selected Reel E REEL R2 R3
Function FA
set to FA REELS
Function FB Function FC

set to FB R2-2 set to FC R1-1

The function buttons are a quick way to mark video clips during
recording. The Functions menu offers two types of markers to
use, as an example FA REELS and FB R2-2 .
« FAREELS

Selecting the FA REELSs programs the FS-4 Pro to mark the

clips to the currently selected reel. The current reel is
indicated in the line above the FA function reel selection.

* FBR2-2

Setting a function button to this type of marker, instructs the
FS-4 Pro to mark the current clip as belonging to the REEL
R2.

Blank

Functions identified as Blank are inactive.
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Utilities Screen

UTILITIES

ORGANIZE REEL
ORGANIZE OMF

ORGANIZE PINNACLE
DELETE CLIP 4

The Utilities available are:
¢ ORGANIZE REEL Fs-4 Pro only
¢ ORGANIZE OMF Fs-4 Pro only
*  ORGANIZE PINNACLE Fs-4 Pro only

« DELETECLIP p
+ FORMAT p

+ REPAIRDISK p

+ REPAIRCLIP p

+  FILE NAME p

+ UPGRADE p

+ SYSTEM RESET p
« DIAGNOSTIC p

. STATUS p
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Organize Reel FS-4 Pro only

This selection places all files identified as a REEL clip during
recording or playback into the appropriate reel folder. You can import
this folder directly into most DV NLE bins.

Organize OMF FS-4 Pro only

When files are recorded in the AVID OMF file format, this selection
allows you to take all the OMF and AIF audio files at the end of a
recording session and place them into a folder on the disk drive
named OMFI MediaFiles. When the disk is connected to a computer,
this folder is recognized by Avid Xpress DV's Media Tool enabling
direct import of files into the Avid timeline. Refer to the section,
“Using Avid OMF Clips FS-4 Pro only” on page 33 for more
information.

Organize Pinnacle FS-4 Pro only

This selection organizes clips for use with Pinnacle Liquid series
NLE systems. Products such as the Pinnacle AVI file format were
created for use with products such as Pinnacle Liquid Edition. The
Pinnacle AVI file format creates three files simultaneously during a
recording; an AVI video file and two separate WAV audio files
labeled as left and right. An additional ALE file for each recording
session is also created which contains timecode data. This file must
be kept with the media.

Once clips have been imported into Liquid Edition, an Index file is
created on the disk drive for each clip. Do not delete this file since it
is required to continue work in the particular project.
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Delete Clip

DELETE CLIP
CLIP 000

YES BACK

Use this item to delete a selected clip.

Step 1:  From the Utilities screen, go to the DELETE CLIP screen.

Step 2:  Enter the number of the clip to be deleted using the Up and Down
navigation buttons.

Step 3:  Press the YES function key.
The selected clip is deleted.
Step 4: Press BACK to return to the Utility screen.
When a clip is deleted, the FS-4 re-organizes and displays the
remaining clips in sequence. For instance, if there are three clips on
the disk: 1-001, 1-002, 1-003. If clip 1-002 is deleted, the remaining

clips are reorganized and clip 1-003 becomes clip 1-002. However the
base file names are not affected.
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Format Disk

FORMAT DISK

PRESS YES TO
ERASE ALL DATA

YES BACK

Prevent lost frames due to file fragmentation by formatting the FS-4
before each recording session.

A Save Files Before Formatting
The formatting process erases all data on the disk and is not
reversible. Backup all files and clips on the FS-4 before formatting.

This selection formats the disk as follows:

Step 1:  From the Utilities screen, go to Format Disk.

Step 2:  Select YES to begin formatting.
A status screen displays progress of the formatting and at
completion displays the message:

» Complete indicating Repair Disk was successful.

» Aborted indicating that there were errors and the repair did not
complete.

Step 3:  Press BACK to return to the Utility screen.
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Repair Disk

REPAIR DISK

PRESS YES TO
REPAIR DISK

YES BACK

Use this function if a recording session does not complete properly
and there is a question that the file may be damaged. For example,
recording terminates due to a loss of power to the FS-4. Repair Disk
scans the entire disk drive checking for and repairing file errors and
incomplete files. When the file is repaired it is can be used in the NLE
system.

Corrupted Files May Need More Repairs
After running Repair Disk some files may still need further work to restore
them. In such a case, run the utility Repair Clip, refer to the following page.

To repair a disk:

Step 1:  From the Utilities screen, go to Repair Disk.

Step 2:  Select YES and the FS-4 begins repairing the disk.
A status screen displays the progress of disk repair and at
completion displays the message:

» Complete indicating Repair Disk was successful.

+ Aborted indicating that there were errors and the repair did not
complete.

Step 3:  Press BACK to return to the Utility screen.
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Repair Clip

REPAIR CLIP

CLIP 000

YES BACK

Use this function to repair a specific file that may be damaged or
incomplete. For example, recording terminates due to a loss of power
to the FS-4 and a specific file may be damaged. Repair Clip scans the
specified file checking for and repairing file errors and incomplete
files. When the file is repaired it is can be used in the NLE system.

Step 1:  From the Utilities screen, go to Repair Clip.

Step 2:  Enter the number of the clip to be repaired, using the Up and
Down navigation buttons.

Step 3:  Press YES and the FS-4 begins repairing the file.
A status screen displays the progress of disk repair and at
completion displays the message:

« Complete indicating Repair Disk was successful.

» Aborted indicating that there were errors and the repair did not
complete.

Step 4: Press BACK to return to the Utility screen.
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Filename

FILE NAME
CLIP 001

20041101 -
165423

This function Displays a filename but does not permit changing it.

Step 1:  From the Utilities screen, go to FILE NAME.

Step 2:  Enter the file’s clip number using the Up and Down navigation
buttons.

The base filename is dynamically displayed as a function of the
clip number.

When a clip has multiple files, the first Base filename is
displayed

Step 3:  Press BACK to return to the Utility screen.
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Upgrade

Check Focus Enhancements website for upgrades and latest software
updates, go to www.focusinfo.com.

To upgrade system software:

Step 1:  Set the FS-4 to HDD Mode and connect it to a computer.
Step 2:  On your computer, rename the XXX.bin file as FS4.bin.

Step 3:  Copy or drag the FS4.bin file to the FS-4 while it is in HDD
mode.

Step 4:  Exit the FS-4 from HDD mode and navigate to the Utilities
screen.

Step 5:  From the Utilities screen, go to Upgrade.
Step 6:  Press Right. The following screen appears.

UPGRADE

PRESS SELECT
TO UPGRADE

SOFTWARE
BACK

Step 7:  Press Select.

Step 8: A confirmation screen appears: press YES to continue.
A status screen displays the progress of the upgrade.

UPGRADE
UPGRADING ...
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Step 9:  Up on successful completion of the upgrade, the FS-4 displays
the message:

UPGRADE
COMPLETE

PLEASE RESTART

Step 10: Hold down the STOP / POWER OFF button until the FS-4 shuts
down.

Step 11: Power up the FS-4.

Upgrade Error
If the upgrade fails, the FS-4 displays the message:

UPGRADE ERROR

WRONG PRODUCT
ID

Check the following:

Step 1: Verify that the upgrade file name is fs4.bin and that it is in
the FS-4 hard drive’s root directory.

Step 2: Verify that the upgrade is for the model of FS-4 it is being
installed on. An upgrade is not cross-platform and must be
installed on the model for which it is intended.

To find the specific model of a FS-4 go to the SETUP
screen and then VERSION, refer to “Setup Screens” on
page 56.
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System Reset

SYSTEM RESET

CONTINUE TO
RESET

SYSTEM?
YES BACK

The System Reset feature restores the factory default settings for the
FS-4 unit. This feature is useful for diagnosing problems with the

unit.
A System Reset
A System Reset can not be reversed.
Diagnostic

A DO NOT CHANGE THE SETTINGS OF THIS FUNCTION

This function is included to assist Focus Enhancement Technical
Support diagnose problems that may occur with the FS-4.
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FireStore Functions

Status

The FS-4 Status screen provides details of the systems power state as
well as internal temperature. This screen may assist Focus
Enhancements Technical Support in determining power and thermal
problems with your unit.
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FireStore Functions

Reels Screen Fs-4 Pro only

When a disk is formatted, the FS-4 Pro creates 10 folders, numbered
0-9, on the disk. During recording or playback of a clip, it is possible
to place it into folders or play it from up to 10 different reels.

These folders can have any name up to 10 characters in length. To
name the folders it is first necessary to enter DD mode and mount the
FS-4 Pro to a computer.

Placing a Clip in a Reel

From the Reels screen, chose the Reels as follows:

Step 1:  From the Utilities screen, go to Reels screen.
Values include:
* FA RO-0 Default Value

* FA R0-0 through R9-9 “Reel Name”

Step 2:  Select a reel from the list.

When selecting a REEL from this screen, the current track is
marked with that REEL number. This can be done in any mode:
record, stop, or playback.
Each of the function keys can be set to specific reel, making it
possible to quickly switch between multiple reels: a total of three
reels being the maximum. Refer to “Functions Screen” on page 64 for
more information.
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FireStore Functions

Using a Wired Remote Control

When using the optional wired remote control, use the button pad
numbered 0-9 to mark the clips. Any additional button presses during a
recording or playback, changes the selected REEL. Once a session is
finished, select Organize REEL in Utilities screen. The marked clips are
placed in the REEL folders in sequential order.

When a REEL is selected, the Home screen menu displays the
REEL’s name on the left side of the second to the last line of the
screen, refer to “LOCAL” on page 83.

Optional Wired Remote Control (p/n ACSS-0019-01)
To order the Wired Remote Control, go to Focus Enhancements website,
www.focusinfo.com/sales/store/.
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FireStore Functions

Play Screen

PLAY

PLAY CLIP
LOOP CLIP

LOOP ALL
PLAY ALL

e Play Clip
In this mode, the FS-4 plays the selected clip from start to
finish when you press the PLAY button. At the end of the
particular clip, the FS-4 pauses.

¢ Loop Clip
In this mode, the FS-4 plays the selected clip from start to
finish. Immediately after completing the clip, the FS-4 begins
playing the clip again without a pause. It stays in this state
until stopped.

e Loop All

In this mode, the FS-4 plays the entire contents of the disk

(all clips), in order, from start to finish. At the end of the last

clip, the FS-4 begins to play from the beginning of the first

clip again without a pause. It stays in this state until stopped.
e Play All

In this mode, the FS-4 plays the entire contents of the disk
(all clips) in order, from start to finish. At the end of the last
clip, the FS-4 pauses.
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FireStore Functions

Play From Screen Fs-4 Pro only

PLAY FROM

TRACK LIST
REEL LIST

This screen permits the selection of from where clips playback.
There are two choices:
e Tracklist
Clips playback in the order in which they were recorded.
Playback order is based on the order of the file names.
* Reel
Clips in a selected folder are played back. This function
provides the ability to choose between any folders on the

disk. Folders can appear with their user assigned folder name
(if used).
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Control Screen

LOCAL
AVIC

-SYNCRO SLAVE
TAPELESS

The Control screen provides the capability of enabling the FS-4 to
operate in four different control modes during record and playback.

e LOCAL

FireStore Functions

Local control mode ignores record triggers from the
camcorder and is controlled exclusively from the FS-4 front
panel or the optional wired remote control unit.

Transport

Keys
Keeper

(cycles through
Reels)

0-9 REEL |
numbers

*  Transport keys have the same functions as on the FS-4.

STOP 1-001
COUNTER
00:00:00:00:
DISK 1 000 min

R1
SYNC DISP LOCK
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FireStore Functions

84

* Usethe Keeper ¢ key to cycle through the available Reels.
For example, if the current Reel selection is 3. pressing Keeper
changes the selection to Reel 4.

To purchase the wired remote control, p/n ACSS-0019-01, for

the FS-4, visit Focus Enhancements web site at

www.focusinfo.com/sales/store/.

AVIC
Otiote

Do Not Use AV/C control in Record Mode

Use AV/C in playback mode and other situations where the
FS-4 is controlled by an external FireWire device such as a
NLE system that is not supported by Direct To Edit
Technology. In these cases, the FS-4 can be used in a manner
similar to a camcorder to capture footage to the NLE.

Using Absolute (ABS) Display Mode

It is recommended that when operating in AV/C mode, the reported
timecode source be changed to Absolute (ABS). This is done through
the LCD DISP mode information fields, see “DISP (display)
Information Fields” on page 44.

Syncro Slave

In Syncro Slave mode, a camcorder and the FS-4 follows the
camcorder’s record state. It requires a tape to be in the
camcorder. To use this mode, refer to the section, “Syncro
Slave Recording” on page 27.

Tapeless Trigger

The Tapeless Trigger mode allows the FS-4 to be controlled
from a camcorder if it features an external control setting
separate from the tape transport. Typical camcorders like this
include the Sony DSR 370, DSR-390, DSR-400, DSR-450,
DSR-570, Canon XL1s and XL2 and the Panasonic DVX-
100/-100A.

In addition, the FS-HD also supports HDV camcorders with
external control, like the JVC GY-HD100.

Camcorder Requirements for Tapeless Trigger

Tapeless Trigger will not work unless it is supported by the camcorder
and the camcorder is placed in this external control mode. Please
check your camcorder manual for more details.



LCD Display Symbols and Text

The table below shows the different symbols and states displayed on
the top line of the LCD when used with different FS-4 control, record,

play and stop modes:
PLAY/REC MODE
Stop

Pause

Play

Rec (Pause)

Normal Rec (Rec)
Retro Disk (Stop)
Retro Disk (Standby)
Retro Cache (Stop)
Retro Cache (Standby)
Loop Record (Stop)
Loop Record (Standby)
Loop Record (Rec)
Snap (Stop)

Snap (Standby)

Snap (Rec)

Time Lapse (Stop)
Time Lapse (Pause)

Time Lapse (Rec) T

FS-4 LCD
STOP

|| PLAY
>PLAY
[IREC
REC

L STOP
L REC
C STOP
CREC
O STOP
O REC
OREC
STOP

|| SNAP
|| SNAP
STOP

I T REC
REC
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LCD Display Symbols and Text

CONTROLTYPE FS-4 LCD

AV/C* (Stop) A STOP

AV/C* (Rec Pause) || A <REC TYPE> REC
AV/C* (Rec) A <REC TYPE> REC
AV/C* (Play Pause) [| APLAY

AV/C* (Play) A ALL

Syncro Slave (Pause) |’ Y <REC TYPE>REC
Syncro Slave (Rec) Y <REC TYPE>REC
Tapeless (Pause) || E<REC TYPE>REC
Tapeless (Rec) E <REC TYPE>REC

* AV/C is only for use when the FS-4 is connected to a computer
system.
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Technical Specifications

Specifications are subject to change.

Physical Description

* Dimensions: 1.59" x 5.6" x 3.74" (40mm x 142mm x 95mm)
(with normal 90 minute Battery)

*  Weight: 1 1b. (.45 kg)

Input/Outputs

* DV Video I/O - 25Mb/s (1x 6-pin IEEE-1394)
On HD units this port can accept 720P and 10801 MPEG
video from specially equipped camcorders.

*  FireWire Computer I/F - up to 400Mb/s (1 x 6-pin IEEE-
1394)

*  GPI & RS-232C Control (1 x 3.5mm mini jack)

Power
« 15V DC, 7.5W

*  Mini-jack power connector

* Custom Removable Li-ion Rechargeable Battery Pack (90
minutes estimated run-time)
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Technical Specifications

Audio/Video/Timecode Specification

e 25Mb/s, 8-bit 4:1:1 (NTSC-DV) or 4:2:0 (PAL-DV) video
(model dependent). The HD models support 1080i and 720P
(30725 or 50/60) from HDV camcorders with a 1394
interface.

* DV Embedded Timecode (Drop or Non-Drop)

* Embedded 2-ch (16-bit, 48kHz) or 4-ch (12-bit, 32kHz)
Audio

DTE File Formats

* RawDV, AVI Type 1, AVI Type 2, Matrox AVI, Canopus
AVI, QuickTime, AVI Type 2 24p NTSC only, QuickTime 24p
NTSC only

¢ FS-4 Pro only
Pinnacle AVI and AVID DV OMF
o FS-4 HD and FS-4 Pro HD Only

M2T

Disk Information
* Internal Disk Type: 40GB (or 80GB - Fs-4 Pro 80 only),
5400RPM, 8 MB cache
¢ Disk Format: FAT32

*  FS-4 compatible with Windows 98SE, ME, 2000, XP and
Mac 0OS9/10.

Log Files

With each recording of a particular clip on a disk, the FS-4 creates a
text log file to identify information about the recorded clip and the
recording session. Information includes:

e Clip name

*  Clip in/out source TC values
*  Clip duration

e Clip type (record file type).

The log file also identifies when the shock cache becomes low and
when disk or other errors occur during a recording.
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Technical Specifications

Error Messages

Error messages may appear on the FS-4 LCD display from time to
time. The purpose of these messages is to alert you to action that may
effect your FS-4 operation. Below is a list of error messages and
actions you can take:

Error Message Description Action

LOW BATTERY! Battery power is low. Connect AC Power or replace the bat-
tery pack.

OVER TEMP! The unit is getting too hot for Make sure the vent and fan intake

normal operation. holes are clear.

NO SPACE LEFT! The Disk Drive is Full. Transfer files off the drive and format it
before attempting to do more record-
ing.

DISK ERROR XXX Lost Disk Communication. Contact Focus Enhancements Techni-
cal Support.

NO DISK Lost Disk Communication. Contact Focus Enhancements Techni-

DETECTED cal Support.

WRONG Incorrect Software Loaded. Download correct software and per-

PRODUCT ID form upgrade again.

Warranty

e 1 year, FS-4/FS-HD
* 2 years, FS-4 Pro / FS-4 Pro HD
* 90 Days Accessories including the battery.

Temperature
*  Operating: 0-40° C (32 - 104° F)
*  Operating humidity: 30% to 90% RH
* Storage temperatures: -20 to 60° C (-4° to 140°F)
»  Storage humidity: 85% RH or less

Compatible Camcorders and Accessories

For a list of tested camcorders, refer to www.focusinfo.com.
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